
Chapter 15

Introduction to 
Injection Mold 

Design
 Learning Objectives 
After completing this chapter, you will be able to:
• Understand the component required in mold design
• Analyze the part fill
• Create core and cavity for the model
• Specify location for gates and runners
• Create mold base for the component
• Create cooling channel for mold
• Create ejection system for mold
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INTRODUCTION TO INJECTION MOLD DESIGN
Injection molding is a process of manufacturing parts by injecting molten material into the mold. 
You can process thermoplastic as well as thermosetting polymers to create parts in injection 
molding machine. 

An injection mold is an assembly of parts containing an impression into which plastic material 
is injected and cooled. This impression is formed by two parts of the mold:
(i) Cavity
(ii) Core

In NX, you can design a mold by using the tools available in the Mold Wizard environment.

INVOKING THE MOLD ENVIRONMENT
Before starting NX Mold Wizard, you need to add NX Mold Wizard library to NX. After that, 
you can use standard parts and material library to create a mold. Start NX by double-clicking 
on the shortcut icon of NX on the desktop of your computer. After the system gets loaded with 
all the files to start NX, the initial interface will be displayed, as shown in Figure 15-1.

Figure 15-1  The initial interface that appears after starting NX 

Next, choose File > Open from the Ribbon; the Open dialog box will be displayed, as shown 
in Figure 15-2.

Now, select the file and choose the OK button; the file will be opened in the Modeling 
Environment, as shown in Figure 15-3. 

To invoke the NX Mold Wizard, choose the Application tab and then choose the Mold tool 
from the Process Specific group; the Mold Wizard tab will be displayed next to the Application 
tab, refer to Figure 15-4. 
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Figure 15-2  The Open dialog box

Figure 15-3  The Modeling environment displayed on screen
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Figure 15-4  The Mold Wizard environment displayed on screen

VARIOUS METHODS FOR CREATING MOLD DESIGN
In NX, you can use the following methods for designing an Injection Mold:
(i)   Manual
(ii)  Semi Automatic
(iii) Automatic
These methods are discussed next.

Manual Method
In manual method, you will not use Mold Wizard but will use Part Modeling, Surfacing, and 
Assembly environments. 

Semi Automatic Method
In semi automatic method, you will use a combination of Mold Wizard, Part, Surfacing, and 
Assembly environments.

Automatic Method
In automatic method, you will use only Mold Wizard environment for designing an injection mold.

ANALYSIS OF PART
For analyzing the part in NX, the Easy Fill Advanced plugin is being used in this book. You can 
also use Run Flow Analysis for analyzing the part but due to some constraints in the results the 
Easy Fill Advanced plugin is preferred for analysis. 

As you install the Easy Fill Advanced plugin, the Easy Fill Advanced tab will become available 
in NX interface. Figure 15-5 shows the Easy Fill Advanced tab.
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Figure 15-5  The Easy Fill Advanced tab

Before analyzing the part using the Easy Fill Advanced plugin, you should check the part 
undercut, draft angle, and wall thickness using the Mold Design Validation and Check Wall 
Thickness tools.

Mold Design Validation
 Ribbon:	 Mold Wizard > Part Validation Gallery > Mold Design Validation	    

This tool helps to check the quality of the molded

Figure 15-6  The Mold Design 
Validation dialog box

 
part. To check the undercut, draft angle, and 
mold part quality, invoke the Mold Design 

Validation tool from the Part Validation gallery of the 
Mold Wizard tab; the Mold Design Validation dialog 
box will be displayed, as shown in Figure 15-6. The 
options in this dialog box are discussed next.

Component Validation
The check boxes available in this area helps to find 
out interference between the electrodes and the 
overlapping of core and cavity sheets. 

Product Quality
The check boxes available in this area helps to find out 
the undercut and the draft angle of the molded part.

Parting Validation
The check boxes available in this area helps to find 
out the face required to split and checks overlap patch 
surface.

As you choose the Execute Check-Mate button from the 
Parameters rollout of the dialog box; the HD3D Tools 
window will be displayed, as shown in Figure 15-7. Depending upon the check box selected in 
the Mold Design Validation dialog box, the resulting parameter will be displayed in the HD3D 
Tools window. In this window, the status of the result is shown by symbols. Following are the 
symbols with their meanings:

  This symbol indicates that the results are passed but there is also some information about     	
  the results.

  This symbol indicates that the results are passed but there is also some warning about the 	
  results.
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  This symbol indicates that the results are passed.

Note
Before using the Mold Design Validation tool, you need to activate the HD3D Tools tab in the 
Resource Bar.

Check Wall Thickness
 Ribbon:	 Mold Wizard > Part Validation Gallery > Check Wall Thickness	  
 Menu:		  Analysis > Molded Part Validation > Check Wall Thickness 	

Part with uniform thickness allows the mold cavity to fill more easily since the molten 
plastic does not have to be forced through varying restrictions as it fills. If the walls are 
not uniform then the thin section cools first as compared to thick section which leaves 

warpage or sink mark in part. You can analyze the thickness using the Check Wall Thickness 
tool. To analyze the thickness of part, invoke the Check Wall Thickness tool from the Part 
Validation gallery of the Mold Wizard tab; the Check Wall Thickness dialog box will be 
displayed, as shown in Figure 15-8, and solid body will be selected in the Body rollout. Choose 
the Calculate Thickness button from the Process Results rollout to analyze the solid body; the 
result will be displayed, as shown in Figure 15-9. Choose the OK button to close the dialog box.

Figure 15-7  The HD3D Tools window Figure 15-8  The Check Wall 
Thickness dialog box
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Figure 15-9  The part with thickness analysis

Easy Fill Advanced
The tools in the Easy Fill Advanced plugin help you to simulate filling, packing and runner 
balancing of injection molding. Next, you need to understand why this plugin is preferred to 
use over NX run flow analysis. 
 
          Parameter                                         Easy Fill                     Easy Fill Advanced

 1)  Simulation capabilities                           Filling                      Filling and Packing

 2)  Runner balance                                      N/A                                      YES

 3)  Gate Number                                         Multiple                           Multiple

 4)  Results availability                                   10                           36 (filling+packing)

 5)  Section Results                                        N/A                                      YES
 
This tab comprises of various tools which are discussed next.
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Set Working Folder
 Ribbon:	 Easy Fill Advanced >  Setting > Set Working Folder			                                                                                                                                                    
 Menu:		  Analysis > Molded Part Validation > Easy Fill  Advanced > Set Working Folder   

This tool helps you to locate the analysis result in the specified folder. To set the working 
folder, choose the Set Working Folder tool from the Setting group of the Easy Fill 
Advanced tab; the Working Folder dialog box will be displayed, as shown in Figure 15-10.

Figure 15-10  The Working Folder dialog box 

Note
If the Easy Fill Advanced message box appears after choosing the Set Working Folder tool then 
choose the Yes button to close this message box.

To locate the folder location, choose the Browse button from the Working Folder dialog box; 
the Open dialog box will be displayed, as shown in Figure 15-11. From this dialog box, you can 
set the directory of the analysis result. After specifying the directory of the analysis result, choose 
the OK button twice to close the dialog boxes.

Figure 15-11  The Open dialog box
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Set Cavity
 Ribbon:	 Easy Fill Advanced > Setting > Set Cavity 				     
 Menu:		  Analysis > Molded Part Validation > Easy Fill Advanced > Set Cavity	

This tool helps you to specify the cavity of the component and assign material to the 
component. To specify the cavity, choose the Set Cavity tool from the Setting group in 
the Easy Fill Advanced tab; the Select Cavity dialog box will be displayed, as shown 
in Figure 15-12. Also, you will be prompted to specify solid body as cavity. Select the 
component from the drawing window. Next, choose the Push button to select material 

button from the Material Setting rollout; the Moldex3D Material Wizard dialog box will be 
displayed, refer to Figure 15-13. You can specify the name of material, producer name, and 
grade name in this dialog box. After specify the material, producer, and grade name; choose 
the OK button from the Moldex3D Material Wizard dialog box and next, choose the OK button 
from the Select Cavity dialog box.

Figure 15-12  The Select Cavity dialog box Figure 15-13  The Moldex3D Material 
Wizard dialog box

Set Runner
 Ribbon:	 Easy Fill Advanced > Setting > Set Runner				     
 Menu:		  Analysis > Molded Part Validation > Easy Fill Advanced > Set Runner	

This tool helps you to define the runner system of the solid bodies. To set the runner 
system, choose the Set Runner tool from the Setting group in the Easy Fill Advanced 
tab; the Select Runner dialog box will be displayed, as shown in Figure 15-14. Choose 
the Specify Runner button from the Runner List rollout; the Select Runner dialog box 
will be displayed, refer to Figure 15-15. Also, you will be prompted to specify the curve 

or solid body to specify as Runner. Select the solid body or curve from the drawing window. 
Choose the OK button to close the dialog box; the Settings dialog box will be displayed. You 
can select type of runner from the Type drop-down list of the Attribute rollout. Choose the OK 
button to close the dialog box. You will notice that type of  runner and name of runner will be 
displayed in the Runner List rollout. Choose the OK button to close the dialog box.
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Figure 15-14  The Select Runner dialog box Figure 15-15  The Select Runner dialog box

Note
If you select a body for setting runner, then you can only define type of runner but if you select a 
curve, then you can define type of runner and its cross-section parameters.

Set Melt Entrance
 Ribbon:	 Easy Fill Advanced >  Setting > Set Melt Entrance			         
 Menu:		  Analysis > Molded Part Validation > Easy Fill Advanced > Set Melt Entrance    

Melt entrance is the path through which molten material comes into the runner. To set 
the Melt Entrance for the runner, choose the Set Melt Entrance tool from the Setting 
group of the Easy Fill Advanced tab; the Melt Entrance Setting dialog box will be 
displayed, as shown in Figure 15-16.

Next, choose the Specify Melt Entrance Position button from the Melt Entrance List rollout; 
the Point dialog box will be displayed, refer to Figure 15-17. By using this dialog box, you can 
place the melt entrance position. Choose the OK button to close the dialog box; the modified 
Melt Entrance Setting dialog box will be displayed. You will notice the Melt Entrance name in 
the Melt Entrance List rollout. Choose the OK button to close the dialog box.
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Figure 15-16  The Melt Entrance Setting dialog box Figure 15-17  The Point dialog box

Set Parting Direction
 Ribbon:	 Easy Fill Advanced > Setting > Set Parting Direction		         	        
 Menu:		  Analysis > Molded Part Validation > Easy Fill Advanced > Set Parting Direction    

Parting direction of the component plays an important role in mold design procedure. 
So, you  need to decide the parting direction carefully. To set the parting direction, 
choose the Set Parting Direction tool from the Setting group in the Easy Fill Advanced 
tab; the Vector dialog box will be displayed, refer to Figure 15-18. Select the direction 

of the partition by selecting the option from the Type drop-down list of the rollout. After 
specifying the correct orientation of the axis, choose the OK button to close the dialog box.

Gate Wizard
 Ribbon:     Easy Fill Advanced > Wizard > Gate Wizard					                   
 Menu:	       Analysis > Molded Part Validation > Easy Fill Advanced > Wizard > Gate Wizard     

This tool helps you to create gate for analysis of flow. To create a gate, choose the Gate 
Wizard tool from the Wizard group in the Easy Fill Advanced tab; the Create Gate 
dialog box will be displayed, refer to Figure 15-19. Choose the Point Dialog button from 
the Position of Gate rollout; the Point dialog box will be displayed. Using this dialog 
box specify the location of the gate and then choose the OK button to close the dialog 

box. Select the type of gate from the Type of gate drop-down of the Attribute rollout. Specify 
the dimensions of the gate cross-section from the Cross-Section Parameters rollout.
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Figure 15-18  The Vector dialog box Figure 15-19  The Create Gate dialog box
In NX, the Easy Fill Advanced plug-in supports various types of gates:

i.	 Pin Gate
ii.	 Sprue Gate
iii.	 Edge Gate
iv.	 Fan Gate
v.	 Lapped Edge Gate
vi.	 Tunnel Gate 
vii.	 Cashew Gate 
viii.	Tunnel Gate with ejector pin
ix.	 Cashew Gate with ejector pin

You can also set them as a Cold Runner or a Hot Runner gate. Depending upon the selection 
of gate, the dimension parameters of gate also gets changed. You can define the size of the gate 
by entering value in the edit boxes of these parameters. After entering the values, choose the 
OK button to close the dialog box.
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Runner Wizard
 Ribbon:    Easy Fill Advanced > Wizard > Runner Wizard				                        
 Menu:	      Analysis > Molded Part Validation > Easy Fill Advanced > Wizard > Runner Wizard  

This tool helps you to create runner system for

Figure 15-20  The Runner Wizard 
dialog box

 
flow analysis of material. You need to select only 
the location of the gate and its size in the model, 
as a result, the runner wizard automatically 
calculates it’s size, shape, and layout. This tool 

helps not only in creation of Runner but also helps in 
designing sprue and  melt entrance. With the help of this 
tool, you can design runner system more efficiently. To 
create a Runner, choose the Runner Wizard tool from 
the Wizard group in the Easy Fill Advanced tab; the 
Runner Wizard dialog box will be displayed, refer to 
Figure 15-20. 

Mold Setting 
This tab allows you to define the parting direction, 
mold plate type, and runner attribute.  

The options of this tab are discussed next.

Parting Direction: The options in this drop-down are 
used to specify the orientation of the runner. The orientation may be along X-axis, -X-axis, 
Y-axis, -Y-axis, Z-axis, -Z-axis or customize it along any vector direction.

Mold Plate Type: The options in this drop-down are used to specify the type of mold. 
According to the selection of the mold plate type the parameters of parting line or plane 
gets changed. The options in this drop-down list are:
(i)  2-Plate mold
(ii) 3-Plate mold

Runner Attribute: The options in this drop-down are used to define the type of runner. 
The options in this drop-down list are:
(i)  Cold Runner
(ii) Hot Runner

Sprue Setting 
      This tab allows you to define the sprue position, sprue length, and sprue diameter. The     	
      options of this tab are discussed next.

       Sprue Position Rollout: The options in this rollout are used to position the sprue.
      
       Sprue Geometry Parameters Rollout: The options in this rollout are used to specify the 	
       size parameters of sprue.
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Runner setting 
       This tab allows you to specify the cross-section and size parameters of runner.

After specifying the parameters of runner, choose the OK button to close the dialog box.

Melt Entrance Wizard
 Ribbon:	 Easy Fill Advanced > Wizard > Melt Entrance Wizard			                                                                                                                                                    
 Menu:		  Analysis > Molded Part Validation > Easy Fill Advanced > Wizard > Melt  		
	             Entrance Wizard				                                                	        

This tool helps you to specify from where molten material comes. To create melt 
entrance, choose the Melt Entrance Wizard tool from the Wizard group in the Easy 
Fill Advanced tab. As you choose this tool, the melt entrance automatically gets 
place in gate or runner location.

Start Analysis
 Ribbon:	 Easy Fill Advanced > Setting > Start Analysis		                     	  
 Menu:		  Analysis > Molded Part Validation > Easy Fill Advanced > Start Analysis	

This tool helps you to apply the settings for the analysis of the component. To start the 
analysis of the component, choose the Start Analysis tool from the Setting group in 
the Easy Fill Advanced tab; the Analysis Setup dialog box will be displayed, refer to 
Figure 15-21. You can specify the process parameters, type of analysis, and the mesh 
level in this dialog box. Choose the OK button to start the analysis; the Moldex3D 

SYNC Project Monitor window will be displayed. This window shows the progress of analysis. 
After the analysis is complete, the Easy Fill Advanced message box is displayed. Choose the 
OK button to close the message box. Choose the OK button to exit the window.
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Figure 15-21  The Analysis Setup dialog box

Show Result
 Ribbon:	 Easy Fill Advanced > Setting > Show Result				     
 Menu:		  Analysis > Molded Part Validation > Easy Fill Advanced > Show Result	

This tool helps you to visualize and analyze the result. To invoke this tool, choose the 
Show Result tool from the Setting group of the Easy Fill Advanced tab; the Show 
Result dialog box will be displayed, as shown in Figure 15-22. Select result from the 
Analysis Result rollout; the dialog box gets modified, refer to Figure 15-22. You can 
select the Filling or Packing option from the Analysis drop-down list in the Display 

Result rollout. By default, the Filling option is selected. You can visualize the results by selecting 
appropriate option from the Result Type drop-down list. Choose the Close button to close the 
dialog box.
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Figure 15-22  The Show Result dialog box and its modified version

MOLD WIZARD
The Mold Wizard tab contains tools that help you to design injection mold automatically. Before 
using this wizard, you should ensure that the library related to the mold is installed. The tools 
in this wizard are discussed next.

Initialize Project
 Ribbon: 	 Mold Wizard > Initialize Project	

The Initialize Project tool is used to create a new mold

Figure 15-23  The Initialize 
Project dialog box

 
design project or to add new model to create a family 
mold. Choose the Initialize Project tool of the Mold 
Wizard tab, the Initialize Project dialog box will be 

displayed, as shown in Figure 15-23.

To specify the path of the project, choose the Browse button 
from the Project Settings rollout; the Open dialog box will be 
displayed, as shown in Figure 15-24.  

Specify the path of the project and then choose the OK button 
to close the dialog box. Select the name of the material from 
the Material drop-down list of the Initialize Project dialog box. 
Next, choose the OK button to close the dialog box.
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Figure 15-24  The Open dialog box

Mold CSYS
 Ribbon: 	 Mold Wizard > Main Gallery > Mold CSYS	

The Mold CSYS tool is used to reposition the original component to the correct orientation 
according to the mold assembly or to the injection molding machine. While positioning 
the component, you should consider following points while placing the component in 
mold wizard:

    • Orient the component so that ejection occurs in z-axis of the mold base.
    • Position the component in such a way that parting plane lies on X-Y plane.

To orient the component, invoke the Mold CSYS tool from the Main gallery of the Mold Wizard 
tab; the MOLD CSYS dialog will be displayed, refer to Figure 15-25.

Figure 15-25  The Mold CSYS dialog box

In the Change Product Position rollout of this dialog box, there are four options to change the 
position of the component. These options are discussed next.
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Current WCS
Select this radio button to reposition the component from the current WCS position and 
orientation to the position and orientation of the mold base.

Product Body Center
Select this radio button to reposition the WCS to the center of the component body. When you 
select this radio button, the Lock XYZ Position rollout will be displayed. The options in this 
rollout help you to lock the position of X,Y, and Z coordinates of the component.

Center of Selected Faces
Select this radio button to reposition the component from the center of one or more selected 
faces to the origin of the mold base. As you select this radio button, the Lock XYZ Position 
rollout gets available. The options in this rollout help you to lock the position of X,Y, and Z 
coordinates of the component.

Select CSYS
Select this radio button to reposition the component to the center of an existing CSYS.

Shrinkage
 Ribbon: 	 Mold Wizard > Main Gallery > Shrinkage     

When a molten plastic filled inside a mold is cooled, it solidifies and shrinks to some 
extent, this process is known as Shrinkage. 

The Shrinkage tool helps you to apply the scale factor on the product model. While defining 
the scale factor, you should consider the following points:
•	 Type of molding material.
•	 Wall thickness of the molded part.
•	 Cavity surface temperature.
•	 Gate shape.
•	 Presence of additive material to the molding materials.

To apply shrinkage on the model, choose the Shrinkage tool from the Main gallery of the Mold 
Wizard tab; the Scale Body dialog box will be displayed.

Type Drop-down List
This drop-down list is used to specify the type of shrinkage that you need to apply to the 
component.

Uniform
       This option is used to scale the body uniformly in all directions.

Axisymmetric
       This option is used to scale the body symmetrically with a specified scale factor about    	
       specified axis.
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General
       This option is used to scale the body with different scale factors  along  the X,Y and Z 	
       directions.

After scaling the body, choose the OK button to close the dialog box.

Check Regions
 Ribbon: 	 Mold Wizard > Parting Tools Gallery > Check Regions   

The Check Regions tool is used to analyze the draft angle of  faces, set the color in the 
faces according to the draft values, and  find undercut in the model. It also helps to find 

the core and cavity regions in the model. To analyze the core and cavity region of the model, 
invoke this tool from the Parting Tools gallery of the Mold Wizard tab; the Check Regions 
dialog box will be displayed, refer to Figures 15-26. Choose the Calculate button in the Calculate 
rollout and then choose the Region tab. In this tab, choose the Set Regions Color button from 
the Define Regions rollout; the color of the model gets changed. These colors represent core, 
cavity, and undefined region in the model.

Figure 15-26  The Check Regions dialog box
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The Cavity Region radio button is selected by default in the Assign To Region rollout. Select 
the undefined region of the model and then choose the Apply button. The undefined region 
gets the color of the cavity region. Choose the OK button to close the dialog box.

Patch Surface
 Ribbon: 	 Mold Wizard > Parting Tools Gallery > Patch Surface	

This tool is used to create sheets to close openings in the model. To patch a surface, 
choose the Patch Surface tool from the Parting Tools gallery of the Mold Wizard tab; 

the Patch Surface dialog box will be displayed, refer to Figure 15-27. In NX Mold Wizard, you 
have three options in the Type drop-down list of the Loop Selection rollout: Face, Body, and 
Traverse. 

 Figure 15-27  The Patch Surface dialog box
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Define Regions
 Ribbon:     Mold Wizard > Parting Tools Gallery > Define Regions      

This tool is used to create core and cavity region sheets, parting lines, and other region 
sheets (for sliders and lifters). To create core and cavity region sheets, choose the Define 

Regions tool from the Parting Tools gallery of the Mold Wizard tab; the Define Regions dialog 
box will be displayed, refer to Figure 15-28.

In the Define Regions rollout, you can examine the number of faces selected for cavity, core, and 
undefined faces which help you to identify the number of  faces belonging  to core and cavity. 
The procedure to create regions for core and cavity will be discussed in Tutorial 1.

Design Parting Surface
 Ribbon:     Mold Wizard > Parting Tools Gallery > Design Parting Surface  

This tool is used to create a parting surface of the component. To create parting surface, 
invoke the Design Parting Surface tool from the Parting Tools gallery of the Mold Wizard 
tab; the Design Parting Surface dialog box will be displayed, refer to Figure 15-29. You 
can use the tools available in the Auto Create Parting Surfaces rollout to create parting 
surfaces. 

Figure 15-28  The Define Regions dialog box Figure 15-29  The Design Parting Surface 
dialog box
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Edit Parting and Patch Surface
 Ribbon:     Mold Wizard > Parting Tools Gallery > Edit Parting and Patch Surface        

This tool is used to delete parting and patch sheets. To edit parting and patch surface, 
choose the Edit Parting and Patch Surface tool from the Parting Tools gallery of the 
Mold Wizard tab; the Edit Parting and Patch Surface dialog box will be displayed, refer 
to Figure 15-30. You can select the type of surface to be edited from the Type drop-down 
list.

Figure 15-30  The Edit Parting and Patch Surface dialog box

Workpiece
 Ribbon:     Mold Wizard > Main Gallery > Workpiece        

This tool helps you to define the size of core and cavity. To define the size, choose the 
Workpiece tool from the Main gallery of the Mold Wizard tab; the New Iray+ Ray 
Traced Studio Rendering window will be displayed. Choose the OK button from this 

window; the Workpiece dialog box will be displayed, refer to Figure 15-31. The options in this 
dialog box are discussed next.

Type Drop-down List
The options in the drop-down list are used to define whether you want to create core and cavity 
for single component or multiple components.

Product Workpiece
This option helps you to create the core and cavity for single component.

Combined Workpiece
This option helps you to create the core and cavity for multiple components.

Workpiece Method Rollout
The options in the drop-down list in this rollout are used to define the way you want to create 
the workpiece. The options available in the drop-down list are:
(i)    User Defined Block
(ii)   Cavity-Core
(iii)  Cavity Only
(iv)  Core Only
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Figure 15-31  The Workpiece dialog box

Dimensions Rollout
The options in this rollout help you to define the size of the workpiece. After specifying the size 
of the workpiece, choose the OK button to close the dialog box.

Cavity Layout
 Ribbon:     Mold Wizard > Main Gallery > Cavity Layout        

This tool helps you to create the layout of core and cavity workpiece. To do so, choose 
the Cavity Layout tool from the Main gallery of the Mold Wizard tab; the Cavity Layout 
dialog box will be displayed, refer to Figure 15-32. Also, the workpiece will be selected 

automatically, as shown in Figure 15-33. The options available in various rollouts of the Cavity 
Layout dialog box are discussed next.
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Figure 15-32  The Cavity Layout dialog box

Figure 15-33 The workpiece selected automatically
Product Rollout
The option in this rollout is used to select the workpiece.
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Layout Type Rollout
The options in this rollout are used to specify the type of orientation to be created. The options 
available in this rollout are discussed next.

Layout Type
The options in this drop-down list are used to define the layout type for the cavity. The 
Rectangular option in this drop-down list is selected by default and helps you to create 
rectangular layout of the workpiece. You can also choose the Circular option from this 
drop-down list to create a circular layout of the component. The Specify Vector area in 
the Layout Type rollout helps you to define the directional placement of the component 
with respect to other component. Specify the parameter of the layout in the Balanced 
Layout Settings or Circular Layout Settings rollout. To create the rectangular or circular 
layout, choose the Start Layout button from the Generate Layout rollout; the preview of the 
layout will be displayed in the window. Next, choose the Close button from the Cavity Layout 
dialog box. Figures 15-34 and 15-35 show the rectangular and circular layouts respectively.

Figure 15-34  The rectangular layout of workpiece 

Figure 15-35  The circular layout of workpiece 
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Define Cavity and Core
 Ribbon:     Mold Wizard > Parting Tools Gallery > Define Cavity and Core        

This tool helps you to create core and cavity of

Figure 15-36  The Define Cavity and 
Core dialog box

 
the component. To create core and cavity of the 
model, choose the Define Cavity and Core tool 

from the Parting Tools gallery of the Mold Wizard tab; 
the Define Cavity and Core dialog box will be 
displayed, refer to Figure 15-36. In the dialog box, the 
Cavity region area is selected by default in the Select 
Sheets rollout. Choose the Apply button; the New 
Iray+ Ray Traced Studio Rendering window will be 
displayed. Choose the OK button; the View Parting 
Result dialog box will be displayed. Check if the core 
or cavity is correct otherwise choose the Reverse 
Normal button. Choose the OK button; the Define 
Cavity and Core dialog box is displayed again. Select 
the Core region area from the Select Sheets rollout. 
Choose the Apply button; the New Iray+ Ray Traced 
Studio Rendering window will be displayed. As you 
choose the OK button to close the window; the View 
Parting Result dialog box will be displayed. Check the 
core or cavity is correct otherwise choose the Reverse 
Normal button. Choose the OK button to close the 
window; the Define Cavity and Core dialog box 
displayed again. Choose the Cancel button to close the 
dialog box. Click the left mouse button and then choose 
the Switch Window tool from the popup mini bar to 
check the core and cavity window.

Mold Base Library
 Ribbon:     Mold Wizard > Main Gallery > Mold Base Library        

The Mold Base Library tool helps you to add mold plates to the core and cavity. To add 
mold plates, choose the Mold Base Library tool from the Main gallery of the Mold 
Wizard tab; the Mold Base Library dialog box is displayed, refer to Figures 15-37. Also, 

the  Information window, refer to Figure 15-38 and the Reuse Library navigator on the left of 
the window will be displayed. Select the standard of the mold base from the MW Mold Base 
Library of the Reuse library navigator and specify the size in the Details rollout of the Mold 
Base Library dialog box and then choose the OK button.



Introduction to Injection Mold Design			    15-27

Figure 15-37  The Mold Base Library 
dialog box 

Figure 15-38  The Information 
window

Standard Part Library
 Ribbon:     Mold Wizard > Main Gallery > Standard Part Library        

The Standard Part Library tool helps you to add the standard parts in the mold like 
sprue bush, locating ring, and so on. To add a standard part, choose the Standard Part 
Library from the Main gallery of the Mold Wizard tab; the Standard Part Management 

dialog box will be displayed, refer to Figures 15-39. Also, the Information window will be 
displayed, refer to Figure 15-40 and the Reuse Library navigator on the left in the window will 
be displayed. Select the standard from the MW Standard Part Library of the Reuse Library 
like locating ring and sprue bush. After specifying the parameters of the parts, choose the OK 
button to close the dialog box.
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Figure 15-39  The Standard Part 
Management dialog box 

Figure 15-40  The Information 
window 

Design Fill
 Ribbon:     Mold Wizard > Main Gallery > Design Fill        

The Design Fill tool helps you to create a gate which connects with core or cavity. To 
create a gate, choose the Design Fill tool from the Main gallery of the Mold Wizard tab; 
the Design Fill dialog box will be displayed, refer to Figures 15-41. Also, the Information 

window, refer to Figure 15-42 and the Reuse Library will be displayed on the left in the drawing 
window. Select the required type of gate from the MW Standard Part Library of the Reuse 
Library and then specify the parameters in the Details rollout of the Design Fill dialog box 
and then choose the OK button to close the dialog box.
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Figure 15-41  The Design Fill dialog box Figure 15-42  The Information window

Runner
 Ribbon:     Mold Wizard > Main Gallery > Runner        

The Runner tool helps you to create the runner which connects with sprue bush and gate. 
To create a runner, choose the Runner tool from the Main gallery of the Mold Wizard 
tab; the Runner dialog box will be displayed, refer to Figures 15-43. Also, the Information 

window will be displayed, refer to Figure 15-44 and the Reuse Library will be displayed on the 
left in the drawing window. Create the sketch of the runner layout and select the type of runner 
cross-section. Specify the parameters of runner and then choose the OK button to close the 
dialog box. 
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Figure 15-43  The Runner dialog box Figure 15-44  The Information 
window

Slider and Lifter Library
 Ribbon:     Mold Wizard > Main Gallery > Slide and Lifter Library        

The Slide and Lifter Library tool helps you to create a slider in mold design. To create 
the slider, choose the Slide and Lifter Library tool from the Main gallery of the Mold 
Wizard tab; the Slide and Lifter Design dialog box will be displayed, refer to Figure 15-45.  

Also, the Information window will be displayed, refer to Figure 15-46 and the Reuse Library 
navigator will be displayed on the left in the drawing window. Select the type of slider from the 
Member Select panel of the Reuse Library and specify the parameter in the Details rollout of 
the Slide and Lifter Design dialog box. Choose the OK button to close the dialog box.
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Figure 15-45  The Slide and Lifter 
Design dialog box 

Figure 15-46  The Information window 

Slider and Lifter Library
 Ribbon:     Mold Wizard > Main Gallery > Slider and Lifter Library        

The Slide and Lifter Library tool helps you to create lifters in mold design. To create a 
lifter, choose the Slide and Lifter Library tool from the Main gallery of the Mold Wizard 
tab; the Slide and Lifter Design dialog box will be displayed, refer to Figures 15-47. Also, 

the Information window, refer to Figure 15-48,  and the Reuse Library navigator will be displayed 
on the left in the drawing window. Select the Lifter from the SLIDE_LIFT sub-tree of the MW 
Slide and Lifter Library tree in the Reuse Library. Select the type of lifter from the Reuse 
Library and specify the parameters in the Details rollout of the Slide and Lifter Design dialog 
box. Choose the OK button to close the dialog box.
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Figure 15-47  The Slide and Lifter 
Design dialog box 

Figure 15-48  The Information window 

Design Ejector Pin
 Ribbon:     Mold Wizard > Main Gallery > Design Ejector Pin        

This tool helps you to create ejector pins that are used for ejection of the component. To 
create an ejector pin, choose the Design Ejector Pin tool from the Main gallery of the 
Mold Wizard tab; the Design Ejector Pin dialog box will be displayed, refer to 

Figure 15-49. Also, the Information Window, refer to Figure 15-50 and the Reuse Library 
navigator will be displayed on the left in the drawing window. Select the type of ejector pin from 
the Member Select panel of the Reuse Library and specify the parameters in the dialog box. 
Position the pin so that the ejection takes place and then choose the OK button to close the 
dialog box, refer to Figure 15-51.
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Figure 15-50  The Information window Figure 15-49  The Design Ejector 
Pin dialog box 

Figure 15-51  The placement of ejector pin

Ejector Pin Post Processing
 Ribbon:     Mold Wizard > Main Gallery > Ejector Pin Post Processing      

This tool helps you to trim the ejector pin. To trim the ejector pin, choose the Ejector 
Pin Post Processing tool from the Main gallery of the Mold Wizard tab; the Ejector Pin 
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Post Processing dialog box will be displayed, refer to Figure 15-52. Also, you will be prompted 
to select the target ejector pins. Select the ejector pins that you need to trim and then choose 
the OK button; the pins will be trimmed and the dialog box will be closed.

Figure 15-52  The Ejector Pin Post Processing dialog box

Sub-Insert Library
 Ribbon:     Mold Wizard > Main Gallery > Sub-Insert Library      

This tool helps you to create and insert those components that go through wear and tear 
regularly or need regular replacement. Generally, the material of the insert is P20 or 

H13. To create the sub-insert in the core and cavity, choose the Sub-insert Library tool from 
the Main gallery of the Mold Wizard tab; the Sub-insert Design dialog box with the Information 
window will be displayed, refer to Figures 15-53 and 15-54. Specify whether you need CORE 
SUB INSERT or CAVITY SUB INSERT from the Member Select area of the Reuse Library 
navigator and then specify the parameters of the insert from the Details rollout of the dialog 
box. Choose the OK button to close the dialog box; the Point dialog box will be displayed. 
Specify the parameter in dialog box and then choose the OK button. Choose the Cancel button 
to close the dialog box.
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Figure 15-53  The Sub-insert 
Design dialog box

Figure 15-54  The Information window

Pocket
 Ribbon:     Mold Wizard > Main Gallery > Pocket      

This tool helps you to create pocket in the mold plates and

Figure 15-55  The Pocket 
dialog box

 
inserts. To create a pocket, choose the Pocket tool from the 
Main gallery of the Mold Wizard tab; the Pocket dialog 

box will be displayed, refer to Figure 15-55. Also, you are 
prompted to select the target bodies, select the required mold 
plates or insert. By default, the Subtract Material option is 
selected in the Mode rollout of the dialog box. After selecting 
the body, click the Select Object area of the Tool rollout. Select 
the tool parts that are to be subtracted like ejector pin and then 
choose the Apply button from the dialog box. Repeat this step 
until the required subtraction has been done. Choose the OK 
button to close the dialog box.

View Manager
 Ribbon:     Mold Wizard > Main Gallery > View Manager      

This tool helps you to manage the display of the mold 
model components. As you choose this tool, the View 

Manager navigator will be displayed, refer to Figure 15-56. The 
functioning of this navigator is similar to assembly navigator. 
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Figure 15-56  The View Manager navigator

Cooling
Cooling is a process required to cool the component. The cycle time of cooling plays an important 
role in mold costing. NX provides you the Cooling Tools gallery in which all the tools related 
to cooling are available. The procedure to create cooling channel are discussed next. 

Pattern Channel
 Ribbon:     Mold Wizard > Cooling Tools Gallery > Pattern Channel      

This tool is used to create the cooling channels using sketches or curves. To create a 
channel, choose the Pattern Channel tool from the Cooling Tools gallery of the Mold 
Wizard tab; the Pattern Channel dialog box will be displayed, refer to Figure 15-57. Also, 

you will be prompted to create the sketch or select the section geometry. After creating the 
sketch, specify the channel diameter in the Setting rollout and then choose the OK button from 
the dialog box.

Figure 15-57  The Pattern Channel dialog box

Direct Channel
 Ribbon:     Mold Wizard > Cooling Tools Gallery > Direct Channel      

This tool is used to create the cooling channel or baffle by specifying a specified point. 
To create a channel, choose the Direct Channel tool from the Cooling Tools gallery of 
the Mold Wizard tab; the Direct Channel dialog box will be displayed, refer to 
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Figure 15-58. Also, you will be prompted to select infer point. Select the start point of the channel. 
Next, select the Distance option from the Motion drop-down list of the Channel Extrusion 
rollout; you will be prompted to specify the vector direction and then enter the length of the 
channel in the Distance edit box. Choose the OK button to close the dialog box. 

Figure 15-58  The Direct Channel dialog box

Extend Channel
 Ribbon:     Mold Wizard > Cooling Tools Gallery > Extend Channel      

This tool is used to extend the length of the cooling channel. To extend the length, 
choose the Extend Channel tool from the Cooling Tools gallery of the Mold Wizard 
tab; the Extend Channel dialog box will be displayed, refer to Figure 15-59, and you 

will be prompted to select the cooling channel. Select the cooling channel and specify the length 
of the cooling channel in the Distance edit box. Choose the OK button; the length will be 
extended and the dialog box will be closed.
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Figure 15-59  The Extend Channel dialog box

Connect Channels
 Ribbon:     Mold Wizard > Cooling Tools Gallery > Connect Channels      

This tool is used to connect the cooling channel. To do so, choose the Connect Channels 
tool from the Cooling Tools gallery of the Mold Wizard tab; the Connect Channels dialog 
box will be displayed, refer to Figure 15-60. Also, you will be prompted to select the first 

cooling channel. Select the first cooling channel; you will be prompted to select the second 
cooling channel. Select the second cooling channel and then choose the OK button to close the 
dialog box.

Figure 15-60  The Connect Channels dialog box
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Adjust Channel
 Ribbon:     Mold Wizard > Cooling Tools Gallery > Adjust Channel      

This tool is used to adjust the position of the cooling channel. To do so, choose the Adjust 
Channel tool from the Cooling Tools gallery of the Mold Wizard tab; the Adjust Channel 
dialog box will be displayed, refer to Figure 15-61. Also, you will be prompted to select 

the cooling channel. Select the cooling channel which you want to adjust; a dynamic triad will 
be displayed on the channel. Move the channel by using handles and angular handles of the 
triad. After positioning the channel, choose the OK button to close the dialog box.

Figure 15-61  The Adjust Channel dialog box

Cooling Fittings
 Ribbon:     Mold Wizard > Cooling Tools Gallery > Cooling Fittings      

This tool is used to add cooling fitting components to cooling channels. To add the 
components, choose the Cooling Fittings tool from the Cooling Tools gallery of the 
Mold Wizard tab; the Cooling Fittings dialog box will be displayed, refer to Figure 15-62, 

and you will be prompted to select the channel. Select the cooling channel and then choose the 
OK button; the dialog box will be closed and you will notice the o-rings in the mold cooling 
channel.
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Figure 15-62  The Cooling Fittings dialog box

Assembly Drawings
 Ribbon:     Mold Wizard > Mold Drawing Gallery > Assembly Drawing     

This tool helps you to create the drawing of the mold assembly. To create the drawing, 
choose the Assembly Drawing tool from the Mold Drawing gallery of the Mold Wizard 
tab; the Assembly Drawing dialog box will be displayed, refer to Figure 15-63. By default, 

the Visibility option is selected in the Type rollout. This option helps you to select the parts of 
the mold you want to show in the drawing. Select the component from the drawing area and 
then select the Drawing option from the drop-down list of the Type rollout. Select the Self 
Contained drawing type from the Drawing Type rollout and select the type of template from 
the Templates rollout. Choose the Apply button. Select the View option from the drop-down 
list of the Type rollout and then select the predefined views from the View Control rollout. 
Specify the scale value in the Scale edit box of  the View Control rollout. Choose the OK button 
to close the dialog box. 
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Figure 15-63  The Assembly Drawing dialog box

Component Drawing
 Ribbon:     Mold Wizard > Mold Drawing Gallery > Component Drawing     

This tool helps you to create and manage the drawing for components of the mold 
assembly. To create a drawing, choose the Component Drawing tool from the Mold 
Drawing gallery of the Mold Wizard tab; the Component Drawing dialog box will be 

displayed, refer to Figure 15-64. Select the component from the list in the Drawing rollout and 
then choose the Create Drawing button from the Create Drawing area of the Drawing rollout; 
the drawing will be generated.
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Figure 15-64  The Component Drawing dialog box

TUTORIAL
To perform the tutorial, you need to download the zipped file named as c15_NX_2020_input from 
the Input Files section of the CADCIM website. The complete path for downloading the file is:

                  Textbooks > CAD/CAM > NX > Siemens NX 2020 for Designers > Input Files

After the file is downloaded, extract the folder to the location C:\NX 2020\ and rename it as c15.

Tutorial 1			        
In this tutorial, you will create mold design of the plastic cover part which is shown in Figure 15-65. 
Here, you will analyze the model and add mold base to it. Also you will create core and cavity, 
runner and gate, and add lifter, ejector pin, and cooling channels to the model.

After creating the mold design, save the mold design with the name c15tut1.prt at the location 
given below:
		  \NX\c15				       		                         (Expected time: 3 hr)
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Figure 15-65  Plastic part for Tutorial 1

	 The following steps are required to complete this tutorial:

a.	 Start NX and open the model. 
b.	 Create a gate for analyzing the model. 
c.	 Create runner and sprue for analyzing the model. 
d.	 Set Parting direction.
e.	 Start analysis and analyze the result.
f.	 Initialize the project.
g.	 Orient the model.
h.	 Create Parting surface.
i.	 Create Core and Cavity.
j.	 Add Mold Base.
k.	 Add lifter for ejection and part shape.
l.	 Add Register ring and sprue bush in mold.
m.	 Add Ejector Pin for ejection of component.
n.	 Create gate and runner.
o.	 Create cooling channel for cooling the component.

Starting NX and Opening the Model
First, you need to start NX and then open a new file.

1.	 Double-click on NX shortcut icon on the desktop of your computer to start NX.

2.	 Choose the Open button from the Standard group of the Home tab or choose 
Menu > File > Open from the Top Border Bar; the Open dialog box is displayed.

3.	 Select Cover_Plastic.prt from the Name list; Cover_Plastic is displayed in the File name 
drop-down list. Then choose the OK button; the model is displayed, refer to Figure 15-66. 
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Figure 15-66  Plastic part in Modeling environment

Analyzing the Model by Easy Fill Advanced 
	 Now, use the tools in the Easy Fill Advanced tab  for analyzing the model.  It is a continuation 

process; if material does not fill properly then you need to do more and more iterations by 
changing the gate, runner, coolant size, shape, or orientation.

1.	 Click on the Easy Fill Advanced tab and choose the Set Working Folder tool from  
the Setting group of the tab; the Working Folder dialog box is displayed.

2.	 Choose the Browse button; the Open dialog box is displayed where you can set the working 
folder, refer to Figure 15-67.

Figure 15-67  The Open dialog box
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Note
If the Easy Fill Advanced message box appears after choosing the Set Working Folder tool then 
choose the Yes button to close this message box.

3.	 Choose the OK button from the Open dialog box and then from the Working Folder dialog 
box.

Creating Gate for Analyzing Model
	 To analyze the model, you need to create a gate.

1.	 Choose the Set Cavity tool from the Setting group of the Easy Fill Advanced tab in the 
Ribbon; the Select Cavity dialog box is displayed, refer to Figure 15-68.

Figure 15-68  The Select Cavity dialog box

2.	 Select the solid body from the Select Body area of the Cavity Setting rollout to specify solid 
body as cavity.

3.	 Choose the Push button to select material button in the Material Setting rollout; the 
Moldex3D Material Wizard dialog box is displayed, refer to Figure 15-69.

Figure 15-69  The Moldex3D Material Wizard dialog box

4.	 Select ABS+PA6 from the Material drop-down list if it is not already selected.

5.	 Select Styrolution from the Producer drop-down list if it is not already selected.
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6.	 Select Terblend N NG-06 from the Grade Name drop-down list.

7.	 Choose the OK button from the Moldex3D Material Wizard and then choose the OK button 
from the Select Cavity dialog box. 

8.	 Choose the Gate Wizard tool from the Wizard group; the Create Gate dialog box is displayed, 
refer to Figure 15-70.

9.	 Select Edge Gate from the Type of gate drop-down list to select the type of gate.

10.	 Select Cold Runner Gate from the Attribute drop-down list if not already selected. 

11.	 Choose the Point Dialog button; the Point dialog box is displayed, refer to Figure 15-71.

Figure 15-70  The Create Gate dialog box Figure 15-71  The Point dialog box

12.	 Select the Point on Face option from the Type drop-down list; you are prompted to select 
the face at point location, refer to Figure 15-72, for face selection.

 
13.	 Enter 0.308 and 0.5 in the U Parameter and V Parameter edit boxes respectively, of the 

Location on Face rollout and choose the OK button from the Point dialog box to exit the 
dialog box.

14.	 Enter 90 and 5 in the Angle and Gate length(L) edit boxes respectively, of the Cross-Section 
Parameters rollout. 
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15.	 Choose the OK button to close the Create Gate dialog box. Refer to Figure 15-73 for model 
with gate.

Figure 15-72  The face selected for gate placement

Figure 15-73  The model with Fan gate

Creating Runner and Sprue for Analyzing Model
	 To analyze the model, you will now create a runner and sprue.

1.	 Choose the Runner Wizard tool from the Wizard group; the Runner Wizard  
dialog box is displayed, refer to Figure 15-74. 

	 By default, the Mold Setting tab is chosen.

2.	 Select - Z-Axis from the Parting Direction drop-down list, 2-Plate mold from the Mold 
Plate Type drop-down list, and Cold Runner from the Runner Attribute drop-down list.

3.	 Choose the Sprue Setting tab and enter 6, 3, and 45 in the D1, D2, and SH edit boxes 
respectively, of the Sprue Geometry Parameters rollout.
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Figure 15-74  The Runner Wizard dialog box

4.	 Choose the Runner setting tab and then select the Circular type of cross section for runner 
from the Type drop-down list and enter 6 in the D edit box.

5.	 Choose the OK button to close this dialog box.

6.	 The gate, runner, and sprue are now attached to the model, refer to Figure 15-75.

Figure 15-75  The runner and sprue with model

Setting the Parting Direction
	 To analyze the model, you will now set the direction of ejection.

1.	 Choose the Set Parting Direction tool from the Setting group to set the parting direction 
of the model; the Vector dialog box is displayed, refer to Figure 15-76.
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Figure 15-76  The Vector dialog box

2.	 Select the ZC-Axis option from the Type rollout if it is not already selected and choose the 
OK button to close the dialog box.

Starting Analysis and Analyzing the Result
	 The Start Analysis and Show Result tools help to analyze and show results. 

1.	 Choose the Start Analysis tool from the Setting group to

Figure 15-77  The Analysis 
Setup dialog box

 
start the analysis of the model; the Analysis Setup dialog 
box is displayed, refer to Figure 15-77.

2.	 Select the Filling & Packing - F P option from the Analysis 
drop-down list of the Analysis Set rollout.

3.	 Enter 220, 0.25, 4.20, 250 and 60 in the Maximum injection 
pressure, Filling time, Packing time, Melt Temperature, and 
Mold Temperature edit boxes respectively, of the Process 
Condition rollout.

4.  Choose the OK button; the dialog box closes and the 
Moldex3D SYNC Project Monitor window showing filling 
and packing analysis progression is displayed, refer to 
Figure 15-78. After the completion of analysis, the Easy Fill 
Advanced window gets displayed, refer to Figure 15-79.

5.	 Choose the OK button from the Easy Fill Advanced window 
and the Close button in the Moldex3D SYNC Project 
Monitor window.
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Figure 15-78  The Moldex3D SYNC Project Monitor window

Figure 15-79  The Easy Fill Advanced window

6.  	 Choose the Show Result tool from the Setting group; the Show Result dialog box gets 
displayed, refer to Figure 15-80.

Figure 15-80  The Show Result dialog box
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7.   	Select result from the Analysis Result rollout; the dialog box gets modified, refer to 
Figure 15-81.

Figure 15-81  The modified Show Result dialog box

	  You can select the Filling or Packing option from the Analysis drop-down list in the Display 
Result rollout. By default, the Filling option is selected.

	 In this tutorial, you can visualize the results by selecting appropriate option from the Result 
Type drop-down list.

	 The options which can be selected for results are Melt Front Time, Air Trap, Weld Line, 
Volumetric Shrinkage, Maximum Shear Stress, and Temperature.

8.	 Select the XY Plot check box to activate the XY Curve Type drop-down list. Next, select the 
Sprue Pressure or Clamping Force option from this drop-down list; the resultant graphs 
are shown, refer to Figure 15-82 through Figure 15-87.
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Figure 15-82  The Sprue Pressure vs Melt Front Time graph

Figure 15-83  The Sprue Pressure vs Air Trap graph

Figure 15-84  The Sprue Pressure vs Weld Line graph

Figure 15-85  The Sprue Pressure vs Volumetric Shrinkage graph
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Figure 15-86  The Sprue Pressure vs Max. Shear Stress graph

Figure 15-87  The Clamping Force vs Temperature graph

9.  Choose the Play button from the Animation Setting rollout. Next, choose the Close button 
to close the dialog box.

10.  Save the file to the specified folder by choosing the Save All button. Close NX.

	 Next, you need to open the model again. To open a file, choose the Open button from the 
Standard group of the Home tab or choose Menu > File > Open from the Top Border Bar; 
the Open dialog box is displayed. Select Cover_Plastic.prt  from the Name list; Cover_Plastic 
gets displayed in the File name drop-down list. Then choose the OK button; the model is 
displayed.
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Initializing the Project from Mold Wizard Tab
	 Now use the Initialize Project tool to define the

Figure 15-88  The Initialize Project 
dialog box

 
material and the path for saving the project.

1.	 Choose the Mold Wizard tab.

2.	 Choose the Initialize Project tool from the Mold 
Wizard tab; the Initialize Project dialog box is 
displayed, as shown in Figure 15-88.

3.	 Choose the Browse button from the Path area of 
the Project Settings rollout; the Open dialog box 
is displayed, as shown in Figure 15-89. After setting 
the path of the project, choose the OK button to 
close the dialog box. 

4.	 Select the Nylon material from the Material 
drop-down list; the Shrinkage edit box gets 
updated automatically depending upon the type of selection of material. Next, select the 
desired template from the Configuration drop-down list. By default, the Mold.V1 template 
is selected. Choose the OK button to close the dialog box.

Figure 15-89  The Open dialog box
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Reorienting the Model	
	 Now use the Mold CSYS tool to reorient the model.                                                          

1.	 Choose the Mold CSYS tool from the Main group of the Mold Wizard tab; the Mold  
CSYS dialog box is displayed, as shown in Figure 15-90; you are prompted to 
double-click on WCS.

Figure 15-90  The Mold CSYS dialog box

2.	 Double-click the WCS, refer to Figure 15-91; you are prompted to drag a handle or select 
a handle. Select the handle of WCS; the WCS Dynamics dialog box is displayed.

Figure 15-91  The WCS (work coordinate system)

3.	 Position the WCS as shown in Figure 15-92.

Figure 15-92  The WCS after positioning
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4.	 Click the middle mouse button to close the WCS Dynamics dialog box.

5.	 Select the Product Body Center radio button from the Change Product Position rollout of 
the Mold CSYS dialog box. Next, choose the OK button from the Mold CSYS dialog box 
to close the dialog box. 

Check Regions
	 You can use the Check Regions tool to check regions of core and cavity.

1.	 Invoke the Check Regions tool from the Parting Tools gallery; the Check Regions 
dialog box is displayed, refer to Figure 15-93. 

 

Figure 15-93  The Check Regions dialog box

2.	 Choose the Calculate button from the Calculate rollout of the Calculate tab and then choose 
the Region tab. Choose the Set Regions Color button from the Define Regions rollout.

    	 Note,  the color of the model gets changed. These colors represent core, cavity, and undefined 
region in the model.

3.	 The Cavity Region radio button is selected by default in the Assign To Region rollout. Select 
the undefined region (back face) of the model and then choose the Apply button. Select the 
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Core Region radio button and select the undefined region (front face) of the model and 
then choose the Apply button; the undefined regions gets the color of the core and cavity 
region.

4.	 Choose the OK button to close the dialog box. Modified model after using the Check Region 
tool is shown in Figure 15-94.

Figure 15-94  The modified model after using the Check Region tool

Creating Core and Cavity Region Sheets
	 To create a parting lines, core, and cavity regions, you need to use the Define Regions tool. 

1.	 Choose the Define Regions tool from the Parting Tools gallery of the Mold Wizard  
tab; the Define Regions dialog box is displayed, refer to Figure 15-95.

2.	 Select Cavity region in the Define Regions rollout and then select Create Regions and the 
Create Parting Lines check boxes from the Settings rollout.          

3.	 Choose the Apply button; a green tick mark appears beside the cavity and core region. 

4.	 Choose the Cancel button to close the Define Regions dialog box.

	 Refer to Figure 15-96 for the parting lines.
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Figure 15-95  The Define Regions dialog box

Figure 15-96  Parting lines of the component

Creating Parting Surface
	 To create parting surface, you need to use the Design Parting Surface tool.
 
1.   	Choose the Design Parting Surface tool from the Parting Tools gallery of the Mold Wizard 

tab; the Design Parting Surface dialog box is displayed, refer to Figure 15-97.

2.	 Choose the Guided Extension button from the Method area of the Create Parting Surface 
rollout.
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Figure 15-97  The Design Parting Surface dialog box

3.  	 Expand the Edit Parting Segments rollout and choose the Edit Guide Lines button; the 
Guide Line dialog box is displayed. Enter 200 in the Guide Line Length edit box. Next, 
select the parting line; a guide line is created, refer to Figure 15-98. Similarly, create other 
guide lines, refer to Figure 15-99. Choose the OK button from the Guide Line dialog box; 
the Design Parting Surface dialog box is displayed.

Figure 15-98  The guide line created
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Figure 15-99  The guide lines created
4.     Select Segment 1 from the Parting Segments sub-rollout of the Parting Lines rollout. Next, 

choose the Swept button from the Method area of the Create Parting Surface rollout. Specify 
first and second direction. Enter 250 as the value in the Extend Distance dynamic edit box 
and choose the Apply button. Similarly, create parting surface for rest of the portion of the 
part, refer to Figure 15-100.

5.   Choose the Cancel button to close the dialog box and the Save All button to save the file.

Figure 15-100  Parting surface of the component

Creating Workpiece 
	 The Workpiece tool helps you to decide the size of the core and cavity insert.

1.	 Choose the Workpiece tool from the Main gallery of the Mold Wizard tab; the New Iray+ 
Ray Traced Studio Rendering window is displayed. Choose the OK button, the Workpiece 
dialog box is displayed, refer to Figure 15-101. By default, the Product Workpiece option 
is selected in the Type drop-down list and the User Defined Block option is selected in the 
Workpiece Method drop-down list. Refer to Figure 15-102 for core and cavity insert size.
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Figure 15-101  The Workpiece 
dialog box

Figure 15-102  The Core and Cavity insert

	 Note, the size of insert is automatically defined. Choose the OK button to exit the Workpiece 
dialog box.

Creating Layouts of the Workpiece
      Now, use Cavity Layout tool to create the layout of the core and cavity insert.

1.	 Choose the Cavity Layout tool from the Main gallery of the Mold Wizard tab; the Cavity 
Layout dialog box is displayed, refer to Figure 15-103. The body of the core and cavity is 
automatically selected and a green tick mark becomes visible in the Select Body area of the 
Product rollout.

2.  	 Enter 4 in the Cavity Count edit box of the Balanced Layout Settings rollout.

3.  	 Click in the Specify Vector area of the Layout Type rollout and select -XC-axis from the 
Inferred Vector drop-down list. Choose the Start Layout button from the Generate Layout 
rollout; the layout gets created, refer to Figure 15-104.

4.	 Choose the Auto Center button from the Edit Layout rollout to center the layout with mold 
base center.



15-62			                 			   Siemens NX 2020 for Designers

Figure 15-103  The Cavity Layout dialog box

Figure 15-104  The cavity layout of the workpiece

5.   Choose the Close button to close the Cavity Layout dialog box.
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Creating Core and Cavity
      Now, use the Define Cavity and Core tool to create the core and cavity.

1.   	Choose the Define Cavity and Core tool from the Parting Tools gallery of the Mold 
Wizard tab; the Define Cavity and Core dialog box is displayed, refer to Figure 15-105.

Figure 15-105  The Define Cavity and Core dialog box

  	 By default, the Region option is selected in the Type drop-down list and the Cavity region 
is highlighted in the Select Sheets rollout. 

2. 	 Choose the Apply button, the New Iray+ Ray Traced Studio Rendering window is displayed. 
Choose the OK button; the View Parting Result dialog box and the cavity of the model get 
displayed, refer to Figure 15-106. Choose the Reverse Direction button to create other half 
of the cavity. Choose the OK button to close the dialog box; a green tick mark is displayed 
in front of Cavity region in the Select Sheets rollout of the dialog box. Now, select Core 
region in the Select Sheets rollout of the dialog box and repeat the same procedure as for 
the cavity; the core gets displayed, refer to Figure 15-107.

	
3.   	Choose the Cancel button to close the dialog box.

4.   	Select Cover_Plastic_parting_xxx in the assembly navigator and right-click on it; a shortcut 
menu is displayed. Choose Cover_Plastic_top_xxx from the Open Parent in Window 
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drop-down list in the shortcut menu.

Figure 15-106  The View Parting Result dialog box and cavity of the model on screen

Figure 15-107  The core of the model

Adding Mold Assembly
	 Now, use the Mold Base Library tool to create the plates for the mold assembly.

1.   	Choose Mold Base Library tool from the Main gallery of the Mold Wizard tab; the Mold 
Base Library dialog box, refer to Figure 15-108 and the Information window is displayed.

2.   	Select 5050, 2, 106, 36, and 106 from the index, TCP_type, AP_h, BP_h, and CP_h 
drop-down lists respectively in the Details rollout. Next, choose the OK button to close the 
dialog box; the Mold plates are added to the assembly, refer to Figure 15-109.
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Figure 15-109  The Mold Plate assemblyFigure 15-108  The Mold Base Library 
dialog box

3.   	Choose File > Save > Save All to save the file. 

Adding Lifter in Mold Assembly
	 Now, use the Slide and Lifter Library tool to create the lifter for mold assembly.

1.   	Choose the Slide and Lifter Library tool from the Main gallery; the Slide and Lifter 
Design dialog box is displayed with the Information window.

2.   	Choose Lifter folder in Main Panel and Dowel Lifter in the Member Select panel of the 
Reuse Library; the Slide and Lifter Design dialog box gets modified with the Information 
window, refer to Figure 15-110.
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Figure 15-110  The Slide and Lifter Design dialog box and the Information window

3.   	Specify the parameter of the Lifter in the Details rollout and

Figure 15-111  The Move 
Component dialog box

 
choose the Apply button.

4.   	You can position the lifter to place it in a correct way. Choose 
the Select Standard Part area of the Part rollout and then 
select the lifter which you want to place.

5.   	Choose the Reposition button in the Part rollout, the Move 
Component dialog box is displayed, refer to Figure 15-111.

6.   	You can place the lifter position using this dialog box, choose 
the OK button after placing the lifter to close the dialog box.

7.   	Choose the OK button to close the Slide and Lifter Design dialog box. Refer to Figure 15-112 
for arrangement of lifter and repeat the same procedure for other lifters.

Note
If you create lifter for one component then other lifters automatically will be placed.
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Figure 15-112  The arrangement of lifter

Trimming the Lifters
	 Now, trim extra part of the lifters.

1.   	Choose the Trim Mold Components tool from the Mold Tools gallery of the Mold Wizard 
tab; the Trim Mold Components dialog box will be displayed, as shown in Figure 15-113.

 
2.	 Select the lifters from the mold assembly and choose the OK button to trim the lifters. Refer 

to Figure 15-114 for the modified lifters.

Figure 15-113  The Trim Mold 
Components dialog box

Figure 15-114  Modified lifters
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Adding Register Ring to the Mold Assembly
	 Now, add Register ring in the mold assembly.

1.   	Choose MW Standard Part Library from the Reuse Library. Expand the MW Standard Part 
Library and then choose the type of locating ring from the Injection folder of DME_MM 
Standard.

2.   	Double-click on the Locating_Ring_With_Mounting_Holes[DHR21] from the Member 
Select panel, the Standard Part Management dialog box is displayed with the Information 
window, refer to Figure 15-115.

Figure 15-115  The Standard Part Management dialog box and the Information window

3.   	Select M8 and 12 in the Type and H drop-down lists. Enter 100 in the D edit box of the 
Details rollout and then choose the OK button; the Information window and the Standard 
Part Management dialog box is closed and another Information window is displayed. Choose 
the Close button to close the window. Refer to Figure 15-116 for arrangement of Register 
ring. 
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Figure 15-116 The arrangement of Register ring in the Mold assembly

Adding Sprue Bush in the Mold Assembly
	 Now, add the sprue bush to the mold assembly. Sprue bush helps to connect the molten 

flow channel between runner and Register ring.

1.   	Choose the MW Standard Part Library from the Reuse Library. Expand the MW Standard 
Part Library and then choose type of sprue bush from the Injection folder of DME_MM 
Standard.

2.   	Double-click on the Sprue Bushing(DHR74) from the Member Select panel; the 
Standard Part Management dialog box is displayed with the Information window, refer to 
Figure 15-117.

3.   	Enter 18, 4, 116, 36, and 24 in the D, O, N, H, and K edit boxes respectively, of the Details 
rollout. 

   	 If the size of sprue bush is not appropriate then you can change it by double-clicking on the 
Sprue Bushing(DHR74) from the Member Select panel; the Standard Part Management 
dialog box is displayed. Select the Select Standard Part area in the Part rollout and then 
select the sprue bush in the mold assembly. Now, you can change the size parameters or 
reposition the sprue bush. Refer to Figure 15-118 for arrangement of sprue bush in the 
mold assembly.

4. 	 Choose the OK button to close the dialog box.
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Figure 15-117  The Standard Part Management dialog box and the Information window

Figure 15-118  The arrangement of sprue bush in the Mold assembly
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Adding Ejector Pin in the Mold Assembly
	 Now, add Ejector Pin to the mold assembly. Ejector Pin helps you to eject the component 

from the mold.

1.   	Choose MW Standard Part Library from the Reuse Library. Expand the MW Standard Part 
Library and then choose the type of ejector pin from the Ejection folder of the DME_MM 
standard.

2.   	Double-click on the Ejector Pin [Shouldered] from the Member Select panel; the 
Standard Part Management dialog box is displayed with the Information window, refer to 
Figure 15-119.

Figure 15-119  The Standard Part Management dialog box and the Information window

3.	 Select 1 and 160 from the CATALOG_DIA and CATALOG_LENGTH drop-down lists in 
the Details rollout. Choose the Apply button; the Point dialog box is displayed. Specify 
the position of the ejector pin by placing the point. Choose the Cancel button to close the 
dialog box. Next, choose the OK button to close the Standard Part Management dialog box 
and the Information window. Refer to Figure 15-120 for the arrangement of ejector pin.
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Figure 15-120 The arrangement of ejector pin in the mold assembly

Trimming the Ejector Pin
	 Now, trim the ejector pin which is larger in size.                  

Figure 15-121  The Ejector Pin 
Post Processing dialog box

1.   	Choose the Ejector Pin Post Processing tool from the 
Main gallery of the Mold Wizard tab; the Ejector Pin Post 
Processing dialog box is displayed, refer to Figure 15-121.

2.   	Select the ejector pins which need to be trimmed.

3.   	Choose the Apply button to trim the ejector pin. Choose 
the Cancel button to close the dialog box.

Creating the Pocket
	 Now, create pocket for components to be placed or moved. 

1.   	Choose the Pocket tool from the Main gallery of the Mold 
Wizard tab; the Pocket dialog box is displayed, refer to 
Figure 15-122. Also, you are prompted to select the target 
bodies. Select the target bodies from the mold assembly.

2.   Select the Select Object area in the Tool rollout and then choose the tool body for which 
you need to create the pocket. Next, choose the Apply button to create the pocket and the 
Cancel button to close the dialog box. Refer to Figure 15-123 for pocket in the core plate.
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Figure 15-122  The Pocket dialog box Figure 15-123  The pocket in the core plate

Creating the Gate
	 Now, you need to create gate. Gate is a channel which directly connects runner and part for 

molten flow of material.

1.   	Choose the Design Fill tool from the Main gallery of the Mold Wizard tab; the   
Design Fill dialog box is displayed with the Information window, refer to 
Figure 15-124.

2.   	Select the type of gate from the Member Select panel in the Reuse Library. For this 
component, use the Fan gate.

3.   	Specify the parameters of the gate in the Details rollout of the dialog box. Select the Select 
Object area in the Placement rollout and specify the gate position and orientation, refer to 
Figure 15-125.

4.   	After placing the gate, choose the OK button to close the dialog box.



15-74			                 			   Siemens NX 2020 for Designers

Figure 15-124  The Design Fill dialog box and the Information window

Figure 15-125  The gate position and orientation in the model
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Creating the Runner
	 Now, you need to create runner. Runner is a channel which directly connects the gate and 

sprue bush for molten flow of material.

1.   	Choose the Design Fill tool from the Main gallery of the Mold Wizard tab, the  
Design Fill dialog box is displayed.

2.   	Select the type of Runner from the Member Select panel in the Reuse Library. For this 
component, use Runner[4].

3.   	Select 6.5 from the D1 drop-down list and enter 92 and 50 in the L1 and L edit boxes in 
the Details rollout of the dialog box. Select the Specify Point area in the Placement rollout 
and position the runner, refer to Figure 15-126.

Figure 15-126  The runner position and orientation in the model

4.   	After placing the runner, choose the OK button to close the dialog box.

Adding Cooling Channel
	 Now, add cooling channel. Cooling channel helps to solidify the material. Effective cooling 

channel helps you to reduce the cycle time.

1.   	Choose the Pattern Channel tool from the Cooling Tools gallery of the Mold Wizard  
tab; the Pattern Channel dialog box is displayed, refer to Figure 15-127.

2.   	Select the Sketch Section button in the Channel Path rollout; the Create Sketch dialog box 
is displayed, refer to Figure 15-128.
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Figure 15-127  The Pattern Channel 
dialog box

Figure 15-128  The Create Sketch 
dialog box

 

3.   Create a sketch for cooling channel on a plane and choose the Finish button to exit the sketch 
environment; the Pattern Channel dialog box is displayed. Specify the diameter of channel 
in the Channel Diameter edit box of the Settings rollout. Choose the OK button to close the 
dialog box. Refer to Figure 15-129 for the position and orientation of the cooling channel.

Figure 15-129  The orientation and position of cooling channel

 Self-Evaluation Test 
Answer the following questions and then compare them to those given at the end of this 
chapter:
 
1.	 The __________ tool is used to define the path of the mold project.

2.	 The __________ tool is used to assign the core and cavity regions in the model.
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3.	 There are __________ types of Configuration in the Initialize Project dialog box.

4.	 You can change the orientation of the model by using the __________ tool. 

5.	 The __________ tool is used to apply a material to a model.

6.	 Gate is a channel which connects sprue bush to the component. (T/F)

7.	 Runner is a channel which connects sprue bush to the gate. (T/F)

8.	 Shrinkage is used to apply scale factor to the component. (T/F)

9.    The Patch Surface tool is used to create the sheet to close the openings in the model. (T/F)

10.  The Design Fill tool is not used to create gate. (T/F)

 Review Questions 
Answer the following questions:

1.	 Which of the following dialog boxes is displayed when you choose the Patch Surface tool 
from the Parting Tools gallery of the Mold Wizard tab?

		  (a) Patch Surface      			   (b) Edge Patch
		  (c) Patch	 			   (d) None

2.	 Which of the following tools in NX Mold Wizard is used to create core and cavity regions?

		  (a) Check Regions			    (b) Define Regions
		  (c) Patch Surface 			    (d) None

3.	 Which of the following dialog boxes is displayed when you choose the Set Cavity button 
from the Easy Fill Advanced tab to specify the cavity of the component?

		  (a) Set Cavity      			   (b) Select Cavity
		  (c) Cavity	 			   (d) Set

4.   The __________ tool is used to create a parting surface of the model.

5.   The __________ tool is used to add cooling fitting components to cooling channels.

6.   The __________ tool is used to adjust the position of the cooling channel.

7.	 You can select the material from the Select Cavity dialog box. (T/F)

8.	 The Design Gate tool is used to create the runner. (T/F)
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9.    The Assembly Drawing tool helps you to create the drawing of the mold assembly.

10.   The Slider and Lifter Library tool helps you to create slider in mold design.

EXERCISE
To perform the exercise, you need to download the zipped file named as c15_NX_2020_input from 
the Input Files section of the CADCIM website. The complete path for downloading the file is:

                  Textbooks > CAD/CAM > NX > Siemens NX 2020 for Designers > Input Files

After the file is downloaded, extract the folder to the location C:\NX 2020\ and rename it as c15.

Exercise 1
Create the Mold Design of the model shown in Figure 15-130. 

Figure 15-130  The Trimetric view of the Phone Case cover

Answers to Self-Evaluation Test
1. Initialize Project, 2. Check Regions, 3. three, 4. Mold CSYS, 5. Initialize Project, 6. F, 7. T, 
8. T, 9. T, 10. F


